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Note: This guide is written for video professionals who are familiar with using Vantage. To design
and implement media processing applications in Vantage, you should know how to create
workflows and submit jobs. If you aren’t familiar with Vantage, we suggest that you review the
Vantage User’s Guide and Vantage Domain Management Guide as needed.
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Integrating Vantage with Frame.l0

Synopsis

Synopsis

Telestream’s Vantage Connector for Frame.io is an optional, licensed Vantage feature
designed to integrate Vantage with Frame.io—the cloud-based visual media
collaboration platform—to automatically upload video assets directly from Vantage to
Frame.io.

Publish to
Frame.io

With the Vantage Connector for Frame.io, editors and assistants no longer have to
waste valuable time with mundane, manual tasks—transcoding media into the proper
format and uploading them to Frame.io. Vantage workflow automation ensures media
is uploaded to Frame.io automatically, minimizing errors and improving efficiency for
seamless collaboration, by review and approval teams.

The Vantage Connector for Frame.io is implemented in Vantage as the Frame.io action.
You can create custom workflows to ingest and prepare media (optional transcoding,
metadata processing, etc.). Include the Frame.io action to connect to Frame.io,
authenticate, and upload the media to a specific team’s project in Frame.io.

You can add a Message action to the workflow after the Frame.io action, to
automatically email team members and let them know the asset is ready for
collaboration and review, and perform other tasks, as required.

Workflows that include publication to Frame.io may be designed for the primary or
exclusive purpose of uploading media to Frame.io However, the Frame.io action can
also be included in larger-scope workflows that include prepping content for on-air and
archival storage, where publication to Frame.io is simply one task in the workflow.

Commonly, after collaboration, other Vantage workflows are utilized for production
transcoding and distribution of the final media.
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Connector for Frame.io Operates in Two Modes

The Frame.io action operates in two different modes, but performs essentially the same
function: uploading media to Frame.io. Each mode is designed for a specific submission
method—interactive mode for direct file submission—and programmatic mode for file
submission via a custom program using the Vantage SDK and the Frame.io SDK.

Interactive Mode

Interactive mode is the mode to choose for a workflow that is intended for directly
submitting media to the workflow for publication. You can drag and drop media
directly on the workflow, add it to a watched folder using a Watch, or batch-process
many files at once, using a Workorder action.

When you configure the Frame.io action in interactive mode, you choose the team,
project and folder using the visual, end-user names that display in the Frame.io web
app. For details, see Up and Running.

Programmatic Mode

Configuring the Frame.io action to operate in programmatic mode enables the
Frame.io workflow to upload files submitted by a custom program or to be integrated
into a larger, web services-based system, where jobs are also submitted
programmatically.

Instead of identifying teams, projects and folders by their visual names in the web app,
their UUIDs are used instead—which must be acquired via the Frame.io SDK. The UUIDs
are passed in as metadata along with the media file, and the workflow is designed to
pass the UUIDs in variables through the actions in the workflow for utilization as
required.

In all other aspects, the configuration is the same as in interactive mode.

For details, see Using Frame.io Workflows in Programmatic Mode.

VST
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Integrating Vantage with Frame.l0

Getting Started

Telestream recommends that you review Prerequisites and then follow the steps in
Installing and Licensing the Frame.io Connector to make sure your systems are updated
and operative.

Next, read Up and Running to create and configure a Frame.io workflow and use it to
upload your media for collaboration in Frame.io.

Two prototype workflows—Prototype Interactive Mode Workflow and Using Frame.io
Workflows in Programmatic Mode—with descriptions, are provided as a template for
your own workflows.

Prerequisites

Vantage

Frame.io

Before you can create and use a Vantage workflow to upload media to Frame.io, you
should meet the following requirements:

Vantage 8.0 + Update Pack 4 must be installed, licensed, and operating properly, with a
maintenance agreement in place as of January 21, 2021. If your maintenance
agreement expired before that date, do not install this patch, as it will cause some
portions of Vantage to cease functioning.

The Vantage Connector for Frame.io patch must be installed, along with the Connector
for Frame.io license. See Installing and Licensing the Frame.io Connector.

You should have an account with Frame.io and be familiar with its operation.

Installing and Licensing the Frame.io Connector

A Connector for Frame.io license enables the Frame.io action in Vantage, and allows it
to execute the Vantage Publish service—which implements the Vantage Connector for
Frame.io—on a specific number of Vantage servers in a given domain.

Installing and licensing the Vantage Connector for Frame.io involves obtaining the
patch installer and license, installing the Frame.io Connector components in Vantage
and adding the license to your Vantage domain.

Obtaining and Adding the Frame.io License

Vantage licenses are managed using the Domain Management Console.

Instructions for installing the license are in the license email that you received.

VST
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Topics for adding and managing licenses are also in the Domain Management Guide—
In the Licenses panel, click the [l button at the far right in the title bar. Or, select Help
> Contents | Index | Search to display the Console guide.

Obtaining and Installing the Connector for Frame.io

The Frame.io Connector is provided as a Vantage patch, which you should install only
on Vantage 8.0 + UP4 with current maintenance as of January 21, 2021. This patch
installs the Vantage Publish service and adds the Frame.io action to Workflow Designer.
To review the release notes, and download and install the patch, follow these steps:

1. Visit the Vantage Customer Center on the Telestream web site and log in with your
credentials.

2. At the bottom of the page in the Updates tab, under the category Additional
Patches—click the Frame.io Connector Release Notes link to the right of the Frame.io
Connector link to open the Release Notes PDF.

3. Read the Release Notes to familiarize yourself with this software update, and take
any action required to satisfy the requirements before proceeding.

4., Also under Additional Patches, click the Frame.io Connector link to download the
patch and save the Vantage_8.0_FramelO_Service_8.0.XXX.X.exe file.

5. Quiesce the Vantage domain—stop submitting jobs and wait for all jobs to
execute, and close all client programs (Vantage Domain Console, Workflow
Designer, etc.) and web apps.

6. Copy this EXE file to each Vantage server where you want the Publish service
installed as the license permits, and run the EXE file to perform installation.

7. Re-open your client programs and continue with your work.

If you need assistance, contact our support team—see Contacting Telestream.

VST
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Up and Running

Up and Running

The process of integrating Vantage with Frame.io involves the creation of a workflow in
Vantage that includes the Frame.io action. Activate your new workflow and then you
can submit media to the workflow for automated uploading.

Note: This topic assumes that you already have Vantage installed with the Connector
for Frame.io licensed and operating, and you have a Frame.io account. See
Prerequisites and Installing and Licensing the Frame.io Connector.

This topic focuses on the big picture: creating a workflow and configuring its Frame.io
action, and then using it to upload media to your account in Frame.io.

The goal is to submit media that you want uploaded, to a Vantage workflow which
automatically uploads it to a specific project’s folder within an account, and then
(optionally) notify your team that it is ready for review. The steps are described below.

1. Obtain a Frame.io Bearer Token

Frame.io integration of course requires authentication. To get started, log into your
Frame.io account and create a bearer token, if you don’t already have one. You'll need it
so that Frame.io can authenticate the Vantage workflow and access your Frame.io
account. Copy and paste the token and save it in a file or an email; once you create it,
you can't display it again in Frame.io for security reasons.

Note: Make certain that the account you use to create the bearer token is the owner
of the project/projects that you intend to reference via Vantage. Also insure that the
bearer token is created with All Scopes (this is an option when creating the token).

It is important that the project owner creates the bearer token. If the token is created by
a member of the project who is not the owner, then the token’s authority will not be
sufficient to list all other components of the project (or other members of sub-projects).

2. Create a Frame.io Workflow

Next, turn your attention to Vantage: specifically, creating a workflow in Vantage
Workflow Designer to prepare and upload media to Frame.io.

Vantage Workflow Designer is a Windows program where you create, manage, utilize,
and monitor workflows to process media. If you don’t know how to create workflows
and submit jobs, we suggest that you review the Vantage User’s Guide as needed.
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Up and Running

Create a sample workflow in your Vantage domain with these actions.

Frame.io | Message

F frame o .. B Asset Name | B Asseti..
B asset iden... !H Asset N...

— B Folder Na... @ “® [ asset id...
B Project Na... | B Folder...

B Reviewur E Project..

Receive job Build Clip name Publish to Frame.io Send message

This prototype workflow is designed to receive a media file, upload it to a specific
project in Frame.io, and notify the team, using variables holding details about the job:
job name, Frame.io media link, etc. In this workflow, the Frame.io action operates in
interactive mode (see Interactive Mode), configured to use the teams and projects in
your Frame.io account.

To configure the Frame.io action, you'll need to know the names of the team, project
and folders you're using in Frame.io.

A complete, detailed description of how to construct and configure this workflow is
described in Prototype Interactive Mode Workflow.

3. Activate Your Workflow

In Workflow Designer, activate the workflow so that it is ready to receive media and
submit a job for processing. Display the workflow and click the Activate button at the
base of the workflow design space.

4, Submit Your Media to the Workflow

Select the media you want to upload and drag it directly on to the Receive action in
Workflow Designer. Vantage displays a confirmation dialog:

Receive Construct ;] | _ | Frame.io " Message

Submit Jobs B Frameio_.. B Asset Name B Assetn...
[E asset iden... B Assetn...

(T) 1o submitted. | W asset .
o E Project Na... I Folder...
B Reviewtiel B Project..

Receive job —— 7 oumwupmere T Publish to Frame.io Send message

Note: You might also upload supporting files to the project: spreadsheets, scripts,
planning documents, etc. Each Frame.io action uploads one file.

/_'\
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5. Monitor the Job

Now, in the Job Status tab, watch the job execute, action by action. Blue borders
indicate success; green borders indicate the action is currently executing:

Receive < Frame.io

piete

John's Account AL New file(s) added

4 Demo Project > MyFolder > SubFolder1

VantageClip_15.37.45 VantageClip_15.14.25 VantageClip_16.08.40 VantageClip_16.04.45

The new file entry displays, along with the new file's name—VantageClip_15.37.45 in
this example—which you assigned in the Frame.io action.

Back in Vantage Workflow Designer, the job completed successfully:

Construct TI

Receive job Build Clip name Publish to Frame.io Send message

/_'\
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6. Begin Collaborating in Frame.io

The workflow’s Message action generated an email based on the template and the
variables, and delivered it to intended recipients.

Frame.io Delivery: VantageClip_15.37.45 - Message (Plain Text)

File Message  Help @ Tell me what you want to do
cwi.. CHPe . . ()
e @ B 2 Me Bl Create a task wi.. C4 perforce Changes ™ B El/ =
L R)I Eany 96 —> ToManager = Tearn Emnail 1 @ A“' ] ;‘1 ” cmDD'
. Delete Archive eply Reply Forward pa # “— . : = love ign  Mar egorize
b2 Al Al Done J Reply & Delete ~ [B=~ | Policy~ Unread =
Delete Respond Quick Steps [F] Move Tags

Frame.io Delivery: VantageClip_15.37.45

john@telestream.net
Te John

The ASSET: VantageClip_15.37.45

was delivered to Frame.lo and placed in the folder: SubFolderl within the Project: Demo Project
Please review this clip at the location: https://f.io/EkHmgCtw

The asset identifieris:  70ede23b-decf-4706-b2d7-2d034f0d7f2a

The variables provided the asset name, the folder and project, along with the asset’s
URL in Frame.io as a link, plus the asset identifier.

Click the asset to open the clip in Frame.io, and begin collaborating with your team.

Manual Submit: Ranch_v2.mp4

You can scrub the video, jog and shuttle, and comment and participate in other aspects
of collaborative activities.

Note: When collaboration is complete, you can also use other Vantage workflows
you've create to transcode and produce your production media.

o~
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Prototype Interactive Mode Workflow

Prototype Interactive Mode Workflow

This topic describes a simple, prototype workflow designed for manual media
submission and how to configure the Frame.io action to operate in interactive mode.

Frame.io I Message O

E Framejo_.. B Asset Name B Asset N...
E asset_iden... F Asset N...

“® B asset id...

B Project Na... B Folder...

B Reviewur B Project...

Receive job Build Clip name Publish to Frame.io Send message

This workflow illustrates the basic requirements for using Frame.io in interactive mode,
plus an optional email generation in the Message action. Your workflow, of course, is
likely to be configured differently, with more complexity, to meet your organization'’s
requirements. For example, this workflow does not perform any prep work or
transcoding prior to uploading, or saving the job binder in a catalog to retain assets
after execution.

1. Create the workflow. In Workflow Designer, create a workflow with the actions
depicted.

2. Configure the Receive action Configure it to ingest one media file. Check the
nickname Original to receive the media file and start the job.

The Receive action starts a job when a file is dragged and dropped on the workflow.
Receive is an appropriate origin action to use when you want to manually process
media.

Note: You can also use a Watch action to monitor folders for new files or a Workorder
action for bulk submissions.

3. Configure the Construct action. Configure it generate a variable with the name of
the file that was submitted for this job so that the name of the file uploaded to
Frame.io is guaranteed to be unique:

— Operation. Construct a String
— Format. Job Name
— Result. File Name

The File Name variable is automatically updated with the name of the file that is
submitted (which, by default is the name of the job as well), and is passed down-
stream for utilization in the Frame.io action and the Message action.

4. Configure the Frame.io action. Configure the Frame.io action, using information
from the Frame.io web app.

/_'\
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5. Use the inspector wizard to specify the action type and bearer token:
- Frame.io action type: Create Asset (Interactive)

— Bearer Token. Paste a Frame.io bearer token into this field, obtained from the
Frame.io web app (see 1. Obtain a Frame.io Bearer Token) to authenticate the
transaction.

Note: The bearer token enables Vantage to communicate with your accountin
Frame.io. If you enter an invalid token, Vantage displays an error message. Resolve
and retry.

Here, Vantage has successfully connected to your account in Frame.io.

x

< C {d & appframeio/projects/74fcl15e-fB78-4d28-a778

John's Account

View Options Help [

L Workflows ~ & FramelO_UploadTest [Active (owner: WE-JOHNK)

Demo Project
fleo =~ FramelO Monitor Status  Job Status  Domain Monitor Status D
My Other Project ?‘ ( — B FramelO_API_Test
|
a 2 3 FramelO_UploadTest

EYiack) (Read Only) Frame.io: Publish to Frame.io RM? X

MyFolder Create Asset (Interactive) : Account “John Kudrle™

Select the Team:
John's Team
Test Team 1

Cancel < Previous Mext >

L i

Workflow Designer—shown here super-imposed over the Frame.io web app where
you have opened the Frame.io action inspector—illustrates the parallel presenta-
tion of account, team, and project information in both products: the Frame.io plat-
form, and Vantage.

VT
telestream



12 | Integrating Vantage with Frame.l0
Prototype Interactive Mode Workflow
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6. Select a team. Vantage queries Frame.io as you configure the action. Select a team
to use for this job and click Next to continue.

Vantage queries the selected team for its projects and displays them:

Demo Project - Frame.io x +

< C (Y & appirame.io/projects/T4fc15e-1878-4d28-aTgm ==aitei—s

\ View Options Help Debu
John's Account = i == e

L Workflows ~ & FramelO_UploadTest [Activ : WE-JOHNK)

4 Demo Project
daills 2 Framel0 Monitor Status Job Status Domain Monitor Status D
B FramelO APl Test
Media e e

(Read Only) Frame io: Publish to Frame.io RM 7T X

Create Asset (Interactive] : Account "John™ : Team “John's Team"

Select the target Pﬂ)jed
Dema Project -
My Other Project
Project3
Some Other Project

‘Cancel < Previous Next >

7. Select the project. Select a project, as shown here—super-imposed against
Frame.io to illustrate the corollary between the Frame.io web app and the Frame.io
action in your Vantage workflow:

8. Click Next to continue.
Vantage queries the project for its folders, if any.

9. Select the Folder. Now, browse and select the folder where you want to upload the
media. See the Demo Project in Frame.io and simultaneously, the same
organization and files displayed in the Frame.io action inspector:

Demo Project « Frame.io x +

& ¢ O @ app.frame.io/projects/74fc115e-f878-4d28-a7cB-4d76b4if4a14/fe513fbec-1670-4389-bd0b-01d17cde26ed w 0O 0 G » o i
John's Account

SubFolder1

Mediz i
? (Read Only) Frame.io: Publish to Frame.io

Create Asset (Interactive) : Account “John Kudrie® : Team “John's Team" : Project “Demo Project™

Select Folder: SubFolderl

%  Frameio Folder Browser

Select a Folder:

VantageClip_15.14.25 VantageClip - [ MyFolder

[ ]
b [ Pre-Production

‘Cancel < Previcus Next >

Vantage
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10. Click Next to continue.

The inspector displays the next panel:

Demo Project - Frame.io x +

<« C {t | B oppiframeio/projects/Tafc!15e-1878-4028-aTg - maitiei i iasaiase maimaat s

| View Options Help Debug
John's Account - ; -

L Workflows ~ & FramelO_UploadTest
M

< FramelO d 8GR Monitor Status  Job Status  Domain Monitor Status
B FramelO_API_Test
3 FramelO_UploadTest

[ (Read Only) Frame.io: Publish to Frame.io RM 7 X 1

) " Create Asset (Interactive) : Account "John” : Team “John's Team" : Project "Demo Project” : Folder ar
Demo Project “SubFolder1®

Media to Publish: I Original

V' Specify Name:
VantageClip_15.14.25

‘Cancel < Previous. Next >

11. Choose the file to send. Select Original, the nickname you chose for the media
your are submitting, so that downstream actions in this workflow can utilize the file
as well.

Also specify the file name you want to use for the file, when uploading it to
Frame.io, so that you can avoid filename collisions. Bind this field to the File Name
variable which you set in the Construct action.

In the Create Variables panel, check all of the variables you want to update:

Demo Project - Frame.io x +

<« C 1) & appframeio/projects/Tafcl15e-f878-4d28-aTg —=mitsms i munsn soma unaniai asiin uan

\ View Options Help Debug
John's Account 8 E 2

L Workflows ~ & FramelO UploadTest

+ FramelO Monitor Status  Job Status  Domain Monitor Status
¥ FramelO_API Test
3 FromelD_UploadTest

[ (Read Only) Frame.jo: Publish to Frame.io R M2 X

Media

Create Asset (Interactive) : Account “John® : Team “John's Team” : Project “Demo Project” : Folder
Demo Project _ *SubFolder]®

‘Generate Vaniables

v ReviewURL: B ReviewUr Path variable to generate

V| Asset Name: [ Asset Name Text variable to generate
VantageClip_15.14.25

v FolderName: B Folder Name Text variable to generate

V' Project Name: B Project Name Text variable to generate

Team Name: ;3

Account Name: (I8

V' Assetidentifiern. B asset identifier ¥ Textvariable to generate

Cancel < Previous Mext >

12. Specify the variables to generate. This includes the URL users can use to access
the media, and the name, folder, and project associated with it, along with an asset

/_'\
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identifier. The information in these variables can be used to compose an email,
delivered to users on this team. They can also be used in any other actions
downstream. Or, you can add them to a label and register the media and label in a
catalog, for persistence and potential re-use outside the context of the job.

13. Configure the Message action to generate an email. Configure Message to
generate an email that the job sends to team members so that they are notified the
job has executed and the media can be reviewed. The details of the email are
collected in the variables pass to it from Construct and Frame.io actions.

Note: Configuring Vantage to process email is beyond the scope of this app note. See
the man page (click on the [} icon in the inspector) for details. If Vantage is not
configured to email utilization, see the Settings & Options > Email tab in the Vantage
Management Console as well.

ST
telestream Vantage



Integrating Vantage with Frame.l0
Using Frame.io Workflows in Programmatic Mode

Using Frame.io Workflows in Programmatic Mode

Vantage

A Frame.io workflow where the Frame.io action is configured in programmatic mode
should be implemented when you are submitting media to the workflow by an
external program or as part of a larger, web services-based system. With the Frame.io
action in programmatic mode, media must be submitted by a program or system rather
than manually.

The program should utilize the Frame.io SDK to obtain team, project, and folder UUIDs.
Then, the program should generate metadata values that meet the workflow
requirements in Vantage. Finally, using the bearer token, utilize the Vantage SDK to
submit the media via a fully-qualified path and the metadata label to the Frame.io
workflow for processing.

Note: Make certain that the account you use to create the bearer token is the owner
of the project/projects that you intend to reference via Vantage. Also insure that the
bearer token is created with All Scopes (this is an option when creating the token).

Itis important that the project owner creates the bearer token. If the token is created by
a member of the project who is not the owner, then the token’s authority will not be
sufficient to list all other components of the project (or other members of sub-projects).

This is a simple, prototype workflow designed for programmatic media submission via
the Vantage SDK:

Pubdish ratarial ta 2 Frarade
systam

Exiract values from meiadata

The workflow should be designed and configured to perform the following tasks:

Configure the Receive action. The Receive action is required to start jobs
programmatically via the Vantage SDK. You'll supply a fully-qualified path to the media
file, and metadata in some form.

Extract metadata and update variables. The Frame.io action requires the following
metadata:

o BearerToken
e Team UUID
e Project UUID
 Folder UUID

You can use actions in the Metadata category (Extract | Lookup | Populate | Transform)
to extract and populate variables with these values, depending on how you supply

o~
telestream
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them to the workflow with the media. For example, you may supply a JSON or XML file,
or a CSV file, etc. The Frame.io requires this data to execute.

Configure the Frame.io action. The Frame.io action should be configured in the same
manner as described in interactive mode, with the exception of assigning the bearer
token and UUID fields to the variables you are using.

VST
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Contacting Telestream

To obtain product information, technical support, or provide comments on this guide
set, contact us using our web site, email, or phone number as listed in the table below:

To obtain the Vantage Connector for Frame.io license, please contact your Telestream
sales representative or your regional authorized Telestream distributor.

Resource Contact Information
Vantage Technical Web Site: http://www.telestream.net/telestream-
Support support/vantage/support.htm

Support Web Mail: http://www.telestream.net/
telestream-support/vantage/contact-support.htm

US Enterprise Product Support: (877) 257-6245
International Enterprise Support: +49 228 280 9141

Telestream Web Site: www.telestream.net
Sales and Marketing Email: info@telestream.net

Telestream, LLC
848 Gold Flat Road
Nevada City, CA. USA 95959

International Web Site: www.telestream.net

Distributor Support  gee the Telestream Web site for your regional authorized

Telestream distributor.

Telestream Technical  Email: techwriter@telestream.net

Writers If you have comments or suggestions about improving

this document, or other Telestream documents—or if
you've discovered an error or omission, please email us.
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Copyright and Trademark Notice

©2021Telestream?®, LLC. All rights reserved. No part of this publication may be
reproduced, transmitted, transcribed, altered, or translated into any languages without
written permission of Telestream, Inc. Information and specifications in this document
are subject to change without notice and do not represent a commitment on the part
of Telestream.

Copyright © 3/20/21 Telestream, LLC and its Affiliates. All rights reserved. No part of this
publication may be reproduced, transmitted, transcribed, altered, or translated into any
languages without written permission of Telestream, LLC. Information and
specifications in this document are subject to change without notice and do not
represent a commitment on the part of Telestream. Specifications subject to change
without notice.

Telestream, CaptionMaker, Cerify, Episode, Flip4Mac, FlipFactory, Flip Player,
Gameshow, GraphicsFactory, Lightspeed, MetaFlip, Post Producer, Prism, ScreenFlow,
Split-and-Stitch, Switch, Tempo, TrafficManager, Vantage, VOD Producer, and Wirecast
are registered trademarks and Aurora, Cricket, e-Captioning, Inspector, iQ, iVMS, iVMS
ASM, MacCaption, Pipeline, Sentry, Surveyor, Vantage Cloud Port, CaptureVU, Cerify,
FlexVU, Prism, Sentry, Stay Genlock, Aurora, and Vidchecker are trademarks of
Telestream, LLC and its Affiliates. All other brand, product, and company names are the
property of their respective owners and are used only for identification purposes.

All other brand, product, and company names are the property of their respective
owners and are used only for identification purposes.
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